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Introduction

As wireless telecommunication features continue to expand into vir-
tually every control and sense technology in military, industrial, and
domestic environments, a wide array of new wireless transmitters
and transmitter components will need to be designed, prototyped,
calibrated, and analyzed for quality assurance. There are many
measurement methods and figures of merit that can be brought

to bear in analyzing transmitter performance. Two such methods,
occupied bandwidth (OBW) and channel power measurements, are
relatively easy measurements to make that can reveal distortion,
poor power amplifier (PA) design, filter effects, system noise, and
other signal degradation factors.

Recently, with the advent of real-time spectrum analyzers (RTSAs),
pulsed, frequency-hopping, and other transient/intermittent signals
can now be characterized using OBW and channel power measure-
ments. Signal Hound's Spike software and one of the Signal Hound
RTSAs, such as a BB60C, can be used to analyze highly modulated
signals and transient signals using built-in occupied bandwidth and
channel power measurement features.

This document will walk through an example setup and testing pro-
cedure for both occupied bandwidth and channel power measure-
ments. The goal of the walkthrough is to demonstrate and explain
the critical aspects of occupied bandwidth and channel power
measurements and how Signal Hound tools can be used to reliably
produce low-cost and low-learning-curve measurements rapidly and
with little setup.
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Overview of Occupied Bandwidth Measurements

For any frequency or phase modulated signal, occupied bandwidth measurements are critical in ensuring that the transmission hardware and
modulation parameters are properly designed to prevent interference and efficient transmission. For example, cellular technologies, Wi-Fi,
and many more recent digital modulated technologies use a variety of modulation parameters, and some are even reprogrammable. Hence,
ensuring that the occupied bandwidth of the modulated transmissions stay within a specified bandwidth under all modulation configurations
can help a designer make the necessary tradeoffs between hardware costs and data rate and bit-error-rate (BER).

As pulsed radar signals and transient modulation signals are nearly impossible to catch with standard spectrum analyzers, RTSAs enable
capture and record of real-time signals, and can be used to illuminate important signal characteristics necessary in identifying and analyzing
pulsed hardware and modulation schemes. OBW is one such measurement, where wide-bandwidth real-time signal capture of an entire
pulsed signal and its transient behavior is necessary to make an accurate analysis of the transmitter and modulations signal characteristics
(see Figure 1).

There are several methods of measuring OBW. However, the general structure of the measurement concludes that OBW is the bandwidth of
a signal in which 99% of the total integrated power of the transmitted spectrum is contained. Some standards also include specific settings for
an analyzer to properly take an occupied bandwidth measurement. For example, the 3GPP dictates that the measurement of the distribution
of the power spectrum is made using a Gaussian filter with a bandwidth greater than 10 MHz and a resolution bandwidth filter (RBW) set to 30
kHz or less for WCDMA modulation.

The order of operations for the measurement is that first the total spectral power in the frequency range is measured. Following this calcu-
lation and beginning at the lowest frequency range in the sweep, the power distribution at each frequency is summed until the summation
reaches exactly 0.5% of the total spectral power within the sweep range. This measurement is repeated inversely starting at the highest
frequency range and summing the power at each frequency until the sum reaches 0.5% of the total power. This method reveals the upper and
lower frequency boundaries of the occupied bandwidth as the 0.5% points.

Ref -30.000 dBm RBW 616 4550
Div 10.0 Atten Auto
| Mkr 1: B7 499714 MHz, -35.033 dBm

¢

VBW 55078 Hz

OCCUPIED BANDWIDTH
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ptal Power = 31 dB

-70.00|
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Figure 1T—Some spectrum analyzer software packages are able to automatically measure occupied bandwidth, saving the
effort of exporting trace data and analyzing it in 3rd party data analysis suites.
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Overview of Channel Power Measurements

From Wi-Fi, Bluetooth, and cellular to broadcast radio stations and satellite TV, much of the usable RF/microwave spectrum is segmented into
designated channels. However, there is very limited spectrum and most countries limit certain applications to a small range of frequencies,
Thus, many telecommunications protocols depend upon tightly packed channels that further subdivide the spectrum in hopes of preventing

interference and optimizing use of the available spectrum.

As not all radio hardware is created equal, some modulation schemes may be more prone to nonlinear distortions and phase noise related
spectral regrowth, and interference from adjacent channels can dramatically reduce communications capability. Measuring the power within a
channel and how much power is also transmitted into adjacent channels can prevent transmitter designs and operation that leads to interfer-

ence.

Channel Power

Measuring the amount of power transmitted within the designed
channel is necessary in the adjacent channel power ratio (ACPR) or
adjacent channel leakage ratio (ACLR) measurements. Additionally,
measuring the channel power can give insight into the efficiency of
the transmission system and the modulation scheme chosen.

Channel power is calculated with a digital spectrum analyzer by
integrating the FFT bins over the programmed channel bandwidth
using the following equation:

f=Freq Start
Pch =
Window Fandwidth

The window bandwidth is equivalent to the noise bandwidth of the
RBW filter setting used, and the Pch result is in milliwatts if the FFT
bin data is provided in dBm. Specifically, for the Spike software, the
average detector and power video units must be selected with the
spur reject algorithm checked as disabled. These settings are neces-
sary to achieve an accurate measurement for channel power, as the

calculation requires a sample detector or root-mean square (RMS)
power averaging detector to be used.

Adjacent Channel Power (ACP) or Adjacent
Channel Leakage (ACL)

Another measurement of interest is the adjacent channel power
(ACP), which is the measured power in the adjacent channels to the
channel of interest. This measurement is performed as the channel
power measurement is performed in the adjacent channels.

Adjacent Channel Power Ratio (ACPR) or
Adjacent Channel Leakage Ratio (ACLR)

The comparison of the amount of power in the primary channel to
the amount of power in the adjacent channels is often used as a
transmitter and modulation scheme figure of merit of the linearity
and noise performance. ACPR is the logarithmic comparison of the
channel power in the primary channel compared to the adjacent
channel power.

P ..
ACPR4g. = 10 % 10910(ﬂ)
Pch

The ACPR measurement is best suited to revealing the significance
of the nonlinear characteristics of the power amplifier, amplifier
subassembly components/connections, and the mixer components.
The impacts of phase noise and the systems noise behavior also
contribute to the ACPR performance of the system.

Fortunately, Spike Software paired with a Signal Hound RTSA en-
ables easy measurement of channel power, adjacent channel pow-
er, and ACPR. Additionally, Spike Software is capable of measuring
the channel power characteristics for more than just the immediate-
ly adjacent channel, and can be configured to measure secondary
and tertiary adjacent channels.
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Equipment and Accessories for ACPR and OBW Measurements

Prior to more flexibly programmed spectrum analyzers and RTSAs, ACPR and OBW were performed by specialized or custom test sets. Typical-
ly, all that is necessary for this measurement is a spectrum analyzer and software with OBW and ACPR measurement modes, the device-un-
der-test (DUT), and the accessory interconnect, cabling, PC, and power supplies. If the spectrum analyzer software isn't capable of OBW and
ACPR measurements, the trace data can be exported and analyzed using a 3rd party software suit capable of mathematical analysis of array
data.

Signal Hound has enabled ACPR and OBW measurements in a very cost effective, efficient, and small footprint implementation with their se-
ries of RTSAs and Spike Software. For convenience and easy demonstration, this guide uses the Signal Hound BB60C for the spectrum analyzer
and the Signal Hound VSG25A to emulate a DUT.

Test Equipment Suggested for ACPR and OBW Measurements:

Signal Hound BB60C

The 27 MHz of instantaneous bandwidth provided by the BB60C enables real-time OBW and ACPR measurements of very
wide-bandwidth signals, transient or continuous. However, if a frequency or phase modulated continuous wave signal is the
desired measurement target, a swept-spectrum analyzer can be used to similar effect. This walkthrough will use the BB60C
RTSA.

Signal Hound BB60C Accessories

* USB 3.0 Double Power Cable—Provided by Signal Hound with every BB60C. These cables need to be connected to a USB
3.0 compatible PC. Only a USB 3.0 compatible PC can adequately supply the necessary power through the USB cables and
carry the digitized frequency data from the RTSA.

* SMA to BNC Adapter—Used for convenient connection to BNC interconnect transmission lines.

Spike Spectrum Analyzer Software (from Signal Hound)

Spike Software requires a PC equipped with Windows 7, 8, or 10 operating system either 32 or 64-bit. For Signal Hounds BB se-
ries RTSAs, an Intel Desktop quad-core i5/i7 processor model number 3000 series or later is required. Additionally, a minimum
of 4 GB of RAM are required, with 8 GB of RAM being the recommended hardware. Spike Software typically requires less than

1 GB of available hard disk space.

Download for free at https://signalhound.com/spike.

Signal Hound VSG25A

A 100 MHz to 2.5 GHz vector signal generator from Signal Hound.

* USB 2.0 Male A to Male B-type—This cable is used to connect the Signal Hound VSG25A to the PC via a USB 2.0 port.

VSG25A w2

Vector Signal Generator

* SMA to BNC Adapter—Used for convenient connection of the VSG25A to the BB60C

Sigoa| Hotrer - ' ) -
3 — « Signal Hound VSG25A Control Software—This software is used to program the VSG25A and is available for free on the
Signal Hound website. http://www.signalhound.com/sigdownloads/VSG25/VSG25_104.zip

— Equipment & Accessories
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* BNC-BNC Cable—This coaxial cable is used to connect the VSG25A to the BB60C during the OBW and ACPR measure-
ments.

* PC with 2x USB 3.0 and 1x USB 2.0 Ports and Necessary Specs— This PC is used to control the VSG25A and to run the
Spike Software and BB60C data.


http://www.signalhound.com/sigdownloads/VSG25/VSG25_104.zip
https://signalhound.com/spike
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Equipment Setup and Configuration for the OBW and ACPR
Walkthroughs

These walkthroughs leverage the Signal Hound BB60C, VSG25A, Spike Software, and VSG25A Software to demonstrate an occupied bandwidth
measurement. The VSG25A is used as the DUT in the measurement as it is a signal generator capable of complex vector modulation, including
frequency modulation.

The connection diagram below describes the appropriate connection and connection types for each component of the OBW and ACPR
measurements. Hand tightening of the SMA to BNC coaxial connectors should be adequate for the SMA ports on the VSG25A and the BB60C.
Conversely, an SMA to SMA cable can be used to directly connect the VSG25A and BB60C.

Note—Test ports will degrade with performance over time and have a finite number of mating cycles before failure. Hence, an intermediate adapter is used to prevent
early test port degradation and failure.

As the VSG25A and the BB60C are both powered by the USB ports of the PC, it is suggested to run the devices on the PC USB ports capable of
supply adequate power to both devices. If two separate USB 3.0 connections are used for the BB60C's dual USB cable and a USB 2.0 connec-
tion is used for the VSG25A, this arrangement should be adequate.

Note—All appropriate protective gear, grounding mats/straps, and a clean environment should be used when operating any electrical measurements.

Setting Up the BB60C with Splke Software Once the BB60C is connected to the PC with the dual USB 3.0 cable
(see Figure 3) and the appropriate drivers and the Spike software
Test equipment setup of the BB60C are installed, a green ready light should appear. This ready light
should turn orange rapidly after booting up the Spike software and
1. Ensure the test environment or operator is properly ground- connecting the BB60C, as the default measurement parameters are
ed and clean engaged and measurement begins.

2. Connect the SMA to BNC adapter to the RF SMA port on the

BB60C
3. Connect the BNC cable to the SMA to BNC adapter. Use-AToUse-8 Dual USB 3.0 Cable
Spike Sof'rware
4. Connect both USB male connectors to the PC USB 3.0 female VSG25A Software
connections

5. Insert the USB cable into the USB 3.0 port of the BB60C

6. Observe the green ‘Ready’ light before proceeding

7. Connect the BB60C with Spike software BNC Coaxial Cable

a. Ensure that Spike software is properly installed

b. Ensure that the USB drivers are properly configured

SMA To BNC
c. Launch the Spike software Adapter SMA To BNC

Adapter
d. Connect the BB60C with Spike software by clicking File >
Connect > BB60C Figure 3—The VSG25A, BB60C, and PC connection order
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Setting Up The VSG25A

After proper installation of the VSG25A control software, the follow-
ing steps connect the VSG25A to the computer.

Test equipment setup of the VSG25A

1. Ensure the test environment or operator is properly ground-
ed and clean

2. Connect the SMA to BNC adapter to the RF SMA port on the
vsg25a

3. Connect the BNC cable to the SMA to BNC adapter (the other
end should already be attached to the BB60C)

4. Connect the USB male connector to the PC USB 2.0 female
connection

5. Insert the USB cable into the VSG25A’s USB 2.0 port

6. Observe the green ‘Ready’ light before proceeding

7. Connect the VSG25A with the VSG25A software
a. Ensure that the VSG25A software is properly installed
b. Ensure that the USB drivers are properly installed

c. Launch the VSG25A software

Figure 4—An Example setup for OBW and ACPR measurements using the Signal Hound BB60C, VSG25A, and Spike soft-
ware with an intel i7 PC.
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Occupied Bandwidth Measurement Walkthrough

The following procedures work through the process of using Signal Hound equipment for occupied bandwidth measurements.

Occupied Bandwidth Sinusoidal Frequency
Modulated Signal Test Procedure

This section of the walkthrough will detail the programming param-
eters and steps of properly measuring the occupied bandwidth of
a 97.9 MHz carrier frequency modulated with a 20 khz sine wave
with an FM deviation of 25 kHz at -30 dBm. The VSG25A is used as
the DUT in the measurement performed by the BB60C RTSA and
recorded and controlled by Spike Software.

1. Setup BB60C and Spike Software for OBW
Measurement

The following steps detail the exact parameter definitions to be
input in the Spike Software. These parameters can be manipulated
as the BB60C is taking measurements. However, if the VSG25A and
BB60C are appropriately connected, the only signal in the measure-
ments before activating the VSG25A should be the noise floor, and
possibly, low-level spurs.

Configuring sweep settings in Spike for OBW measurement

1. From the main menu, select Analysis Mode > Sweep
2. In the Frequency panel, set the following:
a. Center Frequency = 97.5 MHz
b.Span =1 Mhz
3. In the Amplitude panel, set the following:
a. Ref Level =-30 dB
b. Div=10dB
4. In the Bandwidth panel, set the following:
a. RBW Shape = Flat Top, Nutall, or Gaussian
b. RBW = 616.455078 Hz
c. VBW = RBW
d. Select Auto RBW
e. Select Auto VBW

5. In the Acquisition panel, set the following:
a. Video Units = Power
b. Detector = Average
c. Swp Time = 1.000 ms
6. In the Traces panel, set the following:
a. Trace = One
b. Type = Clear & Write
c. Avg Count=10
d. Color = yellow
e. Select Update
f. Deselect Hide
7. In the Offsets panel, in the Ref Offset field, type 0.000.
8. In the Occupied Bandwidth panel, set the following:
a. Select Enabled

b. % Power = 99.000

|
i

Figure 5—Signal Hound's Spike software can be configured to measure occu-
pied bandwidth with the click of an enable option.
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2. Setup VSG25A for the measurement

When launching the VSG25A software, a dialog with all of the
programmable parameters of the VSG25A will open. The image and
configuration parameter listing below provides the description of
how to generate a sinusoidal frequency modulated signal at 97.5
MHz with a modulation rate of 20 kHz and FM deviation of 25 kHz at
-30 dBm power level.

Configuring The VSG25A for OBW Measurement

1. Select the FM button in the panel on the right-hand side of
the window.

2. In the fields near the top of the window, set the following:
a. Frequency (MHz) = 97.5
b. Amplitude (dBm) = -30
3. In the Frequency Modulation panel, set the following:
a. Modulation Rate (kHz) = 20
b. FM Deviation (kHz) = 25
c. Modulation Shape = Sine Wave
4. Click Apply Settings

Note—This must be done before proceeding to the next steps.

5. In the RF pane, select On

6. In the Mod pane, select On

E Signal Hound Vector Signal Generator — O X

File Presets Device Help

97.5 -30
Frequency Modulation Wi '\MW\I
Modulation Rate (kHz) (0.05 - 40000.0) AM
FM Deviation (kHz) (0.0 - 50000.0 "P I—l "
ulse
Modulation Shape . Sine Wave w TAM
v Triangle Wave ASK | PSK
L Square Wave ESK | NaR
~ Ramp Wave |
Ramp | Step
Eorvrem|Erares)
Apply Settings Bev
Arb
F d
On On
o of
FM VSG25A -- s/n 50900027 |

Figure 6—Configuring the VSG25A for FM modulation



3. Analyzing the Measurement

After applying the RF On setting, a single tone should appear at 97.5
MHz. Once the Mod settings is On, then the sinusoidal frequency
modulation should become apparent as several tones appear sym-
metric around 97.5 MHz. The diagram below indicates observable
areas of interest. A marker is used to show that the peak frequency
of the signal is at the desired 97.5 MHz. The marker settings on the
left-hand side of the Spike Software panel can be used to adjust

the marker parameters and create new markers. To place a marker
on the peak frequency, simply click “Peak Search” in the Markers
selection field.

Ref -30.000 dEm RBW 616.455078 Hz
Jiv 100 A Auto

Marker Indicator

OBW Lower

Modulated Signal

oise Floor I “ I'H
N FI I W Mw i
’ﬂ' 'T‘ i

OBW And Total
Power Display

kHz

-130.00!
Start 97.000000 MHz Genter 97.500000 MHz
Span 1000000 I

The modulated signal should be located at roughly 97.5 MHz with
a power level within several dBm of -30 dBm. However, the signal
should have less than -30 dBm of power at the peak frequency

as some signal power is spread over the modulated signal range.
The occupied bandwidth feature should create upper and lower
frequency markers designating the boundaries within which 99%
of the power is contained. There is a OBW display window on the
bottom left of the measurement window, which indicates the OBW
measurement and the total power of the signal. The total signal
power should be within a few fractions of a dBm of -30 dBm.

It should be observed that the occupied bandwidth of the signal
is much greater than the modulation depth and the FM deviation
settings of the transmitter. This effect occurs as a result of the
resultant tones of the pure sinusoidal modulation, as well as the
imperfect linearity, noise, and phase noise characteristics of the
transmitter.

Ml'rl 7.499714 M
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Occupied Bandwidth Measurement for
Pulsed or Intermittent Signals

Unlike with continuous wave signals, pulsed signals and transient
signals may not necessarily have consistent characteristics in time
of frequency. In the case of some signals, such as pulsed radar,
these signals may demonstrate consistently repeating pulsed
square wave signals with set repetition rate, constant pulse width,
constant shape, and amplitude. In this case, it is easy enough to
trigger on this signal and accurately measure its characteristics,
including occupied bandwidth.

However, for pulsed or transient signals that may be intermittent
or have unknown characteristics, taking these measurements may
be a greater challenge. Fortunately, a real-time spectrum analyzer
is able to observe and measure this transient behavior down to the
attack time limits of the analyzer. Several tools exist to help identify
and measure intermittent time-varying signals, such as a waterfall
spectrum display (spectrogram), persistent display, max-hold, zero
span mode, and etc.

The following walkthrough will demonstrate using the max-hold and
trace-data export features to provide detailed analysis, including
occupied bandwidth, for pulsed and other transient signals. The
export of trace data is necessary, as Spike Software’s occupied
bandwidth measurement feature will currently only measure the
incoming data instantaneously.

1. Setup BB60C and Spike Software for the Pulsed
OBW Measurement

As this measurement also uses the VSG25A and the same frequen-
cies are used as in the continuous wave OBW measurement, the
configuration of the BB60C and Spike Software is the same as the
previous measurement. See 1. Setup BB60C and Spike Software for
OBW Measurement for details.

2. Setup VSG25A for the Pulsed OBW Measurement

This measurement will use the VSG25A to generate a square pulse
wave with consistent frequency and timing characteristics at 97.5
MHz with a pulse width of 100ms and a pulse period of 1000ms at
-30 dBm power level.

Configuring The VSG25A for Pulsed OBW Measurement

1. Select the Pulse button in the panel on the right-hand side
of the window.

N

. In the fields near the top of the window, set the following:
a. Frequency (MHz) =97.5
b. Amplitude (dBm) = -30

w

. In the Pulse Modulation panel, set the following:
a. Pulse Width (us) = 100

b. Pulse Period (ms) = 1000 (the equivalent of 1 second)

B

. Click Apply Settings

Note—This must be done before proceeding to the next steps.

(5]

. In the RF pane, select On

o

. In the Mod pane, select On

[ signal Hound Vector Signal Generator - [m} X
Fle Presets Device _Help
Amplitude (dBm)
500 -30
Pulse Modulation | A
Pulse Width (us) 1000‘ (0.006 - 25000.0) AM EM
Pulse Period (ms) 1000‘ (0.00001 - 1000.0) S M
Pulse | . __
Apply Settings M Vi
EQCK NAN
A ——
Kamp | Step
Cuiaan|Quaa: "
B
Arb
RF Mod
On On
off off
Pulse VSG25A -- s/n 50900027 .

Figure 8—The VSG25A configured for a pulsed OBW measurement




Now you can use 2D spectrogram mode within the Spike software
to monitor and confirm the appropriate signal characteristics over
time, bandwidth, and amplitude.

7. In the upper left-hand corner of the Spike software interface,
from the Spectrogram menu, select 2D Spectrogram.

Spike now displays the RF activity in the spectrum waterfall plot (see

Figure 9).

As the signal is apparently pulsed at an even pulsing ratio, a method

of catching the highest power at each frequency of interest is to use
the Max-hold trace mode instead of the clear and write trace mode.

Ref -30.000 dBm RBW 1 000000 kHz VBW 1.000000 kHz
D 0

.00
Start 97.000000 MHz Center 97.500000 MHz Stop 98.000000 MHz
Span 1.000000 MHz 3277 pts.in 31 ms

Figure 9—A 2D Spectrogram reveals the intensity of power levels within the sweep range. However, a
real-time spectrum analyzer is capable of capturing even extremely short duration signals as long as they
are contained within the instantaneous bandwidth of the analyzer.

Occupied Bandwidth Measurement Walkthrough — 15
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Using Max-Hold Trace Mode with Spike
Software

The Max-Hold feature of Spike Software uses the highest power lev-
el yet measured in each frequency bin and displays that as a trace.
This approach reveals the highest power at each frequency over the
length of observation. Spike Software enables multiple traces to be
viewable in the same display. If a second trace is configured to have
the Max-Hold property, than both a clear and write and Max-Hold
trace can be displayed for comparison.

Creating A Second Trace with Max-Hold Mode

While Spike is displaying pulsed data from the VSG25A, do the
following:

1. In the Traces panel, from the Trace drop-down menu, select
Two.

2. From the Type drop-down menu select Max Hold

3. Click the color swatch in the Color field. The Select Color
window appears.

4. In the Select Color window, either click on a color chip or
use the available fields to configure your trace color, and
click Ok.

5. Select Update

RBW 2 465820 kHz
Atten Auto

Ref -30.000 dBm
Div 10.0

rt 97.399800 MHz

Figure 10—The Max-Hold trace in red and clear write trace in yellow demon-
strate that the Max-Hold trace is able to reveal the highest power levels at
each individual frequency and hold those values for comparison.

Export and Analyze Trace Data

As Spike Software is unable to perform an occupied bandwidth
measurement on anything but instantaneous data from the BB60C,
external tools will be necessary to calculate the OBW. This can be
down by exporting the trace data and further analyzing the data in
3rd party software. The export function will export a CSV file (.csv)
that can be read by other software and can be further analyzed.

Exporting the Max-Hold Trace Data from Spike Software

While Spike is displaying pulsed data from the VSG25A, do the
following:

1. In the Traces panel, from the Type drop-down menu, select
Max Hold

2. Near the bottom of the Traces panel, click Export

3. Save the CSV file in an appropriate location to be accessed
by the 3rd party software

The CSV is now ready for analysis by any of the software tools
available on the market for analyzing array data from CSV files. Ex-
amples include MATLAB™, LABVIEW™, Microsoft™ Excel, and many
others.
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Channel Power and Adjacent Channel Power Ratio Walkthrough

This section of the walkthrough will demonstrate the use of Spike Software’s built in channel power, adjacent channel power, and adjacent
channel power ratio measurement features. The first two sections of this walkthrough use the VSG25A as the signal generating DUT.

Channel Power Measurement Procedure

The following procedure works through the process of using Signal
Hound equipment for channel power measurements.

1. Setup the BB60C, VSG25A, and Spike Software
for a Channel Power Measurement

Using the same settings specified in the Occupied Bandwidth Mea-
surement Walkthrough for the VSG25A, BB60C, and Spike prepares
the equipment for the walkthrough. This time, however, the only
difference is that the Channel Power Settings are configured in-
stead of manipulating the Occupied Bandwidth parameters.

2. Configure the Channel Power Settings

As with the OBW measurement, Spike provides a convenient
measurement field. In the same field as OBW, Channel Power
measurement can also be configured and programmed to auto-
matically perform channel power and adjacent channel power ratio
measurements. It is important to note that the center frequency of
the primary channel should be the center frequency of the frequen-
cy sweep programmed in the Frequency fields. The Channel Power
measurements assume that the center frequency desired in the
sweep center frequency.

Channel Power

|

Width | 200.000000 kHz |
Spacing | 200.000000 kHz |
Count | 5.000|
Enabled U
Enabled O
% Power | 99.000|

The Width field sets the bandwidth of the channel to be measured.
The Spacing field dictates the center-frequency to center-frequency
spacing of the channels. For example, to measure a channelized
modulation protocol with guard bands, the Width can be set to the
maximum channel bandwidth minus the sum of the guard band
bandwidths.

Configuring Spike for channel power measurements

While Spike is displalying data from your test setup:

1. In Spike, in the Channel Power panel, set the following:
a. Width = 200 kHz
b. Spacing = 200 kHz
c. Count=1

2. Select Enabled

3. Observe The Channel Power Measurement

The results of the Channel Power measurement are a number in
dBm below, and in the center, of the channel of interest. A grey
shaded area is placed on the frequency display, which indicates the
channel being measured (see Figure 11).

Fv \muam RBW 616.45! VBW 616.455078 Hz
Div. ito
Mkr 1: §7.499714 MHZ, -35.068 dBm|

|

| bt l\ MM ‘
m M M |
. W W‘,
”’W’M‘f\\MﬁWWMW’WWW Af

l -30.928 dBm

NW M
ﬂ M' "! h “w i MW‘W‘W

il

rt 97.000000 MHz. 500000 MHz E n MH
00000 MHz ms

Figure 11—The Channel Power measurement reveals the total power within

a programed channel. If a signal has highly linear and low noise/phase noise

characteristics, the majority of the transmitted signal power should be con-
tained within the primary channel.
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Adjacent Channel Power Ratio
Measurement

Where the channel power measures the total power within a chan-
nel, adding additional “counts” or channels in the Channel Power
field in Spike Software, will automatically measure the power in

the adjacent channels and provide a ratio of the adjacent channel
power to the primary channel.

1. Configure the Channel Power Settings

The only configuration difference between ACPR and CP measure-
ments are the use of the “count” field. Changing the count field will
increase the number of channels that are including in the channel

power measurements.

Configure Spike for channel power measurements
While Spike is displalying data from your test setup:

1. In Spike, in the Channel Power panel, set the following:
a. Width = 200 kHz
b. Spacing = 200 kHz
c. Count=3

2. Select Enabled

2. Observe the Channel Power and ACPR
Measurements

Once the Enable field is selected, grey fields will appear designating
each channel being measured. A count of 3 measures the primary
channel and the two adjacent channels (see Figure 13). The Channel
Power and the ACPR are displayed in the center of each measured
channel. The ACPR measurement is displayed below the Channel

Power and is in the units of “dBc”, which are scalar logarithmic units.

RBW 616.455078 Hz.
Atten Auto

VBW 616.455078 Hz

Mkr 1: §7.499714 MHZ, -35.078 dBm|

i H\ *\ YM’I‘M“ ’ ‘
» ‘”m W‘f’ 'J! w Uﬁw ,\)MW WtMMW'WMW'}MW”V’W’TJ“

-82.987 dBm -30.939 dBm -83.433 dBm
-52.05 dBc -52.49 dBc

97.000000 MHz C 500000 MHz
00000 MHz.

Figure 12—The ACPR measures the amount of signal energy that has bled
into the adjacent channels, and can be used to predict interference. This
measurement requires a closed system test, as outside interference could
artificially inflate the power in the adjacent channels compared to the primary
channel.
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Figure 13—Changing the “Count” field in Spike Software to 4 or more extends
the adjacent channel power ratio measurement beyond the immediately
adjacent channels.
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Further Reading

Download the Spike software manual from www.SignalHound.com/spike for more OBW and CPM information.

About Signal Hound

The Signal Hound® company started as Test Equipment Plus (TEP) in 1996 with the belief that providing quality used test equipment, at affordable
prices to every customer, would drive growth and foster loyal customers. It did. Then in 2006, TEP expanded their focus by designing and manufacturing
a color LCD display retrofit kit to answer the need for CRTs that were no longer available for the aging HP® 8566A, 8566B, 8568A, and 8568B spectrum
analyzers. TEP also began offering a repair service for HP/Agilent® step attenuators. In 2007 TEP designed and began manufacturing another color LCD
display retrofit kit to support the HP/Agilent 8560 series spectrum analyzers. At the same time, TEP also decided to play to their strengths, and began
offering test equipment repair services for Agilent spectrum analyzers, network analyzers, and signal generators. The repair segment of TEP is now

recognized in the RF and microwave test equipment industry as a world class operation.

The LCD kits were so well received that in 2009, TEP decided to design a compact, lightweight, and inexpensive spectrum analyzer. The goal was to
provide an economical spectrum analyzer with unparalleled value compared to anything else on the market. TEP achieved that goal with the USB-SA44
spectrum analyzer which was introduced in February 2010, marking the birth of the Signal Hound line of test equipment. In April of 2014, Test Equip-
ment Plus began officially doing business as Signal Hound. Signal Hound's latest innovation is the Signal Hound BB60C spectrum analyzer, introduced

June 2014, which is an enhanced version of its well-received predecessor, the BB60A.
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